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2 Preface 
 

Dear customer! 
 

Thank you for choosing a product from us! 
Please take some time to read this manual carefully. Please pay special attention to the 
safety instructions. 
This is the condition for safe handling and operation of the system and its 
components. 
If you have any questions that are not answered in this manual, please feel free to call us. 
We will be glad if we can help you. We are also always happy to receive suggestions or 
ideas. 
Our products are subject to constant further development; therefore, there may be minor 
deviations between your system and the illustrations in this operating manual. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2017 
Opsytec Dr. Gröbel GmbH 
Am Hardtwald 6-8 
D - 76275 Ettlingen 
Tel.: +49(0)7243 / 9 47 83-50 
Fax: +49(0)7243 / 9 47 83-65 
info@opsytec.de 

 
All rights reserved. Reprinting, including excerpts, is only permitted with the written 
consent of Opsytec Dr. Gröbel GmbH. 

mailto:info@opsytec.de


3 Brief instructions for spectroradiometric 
 

5 
 

 

3 Quick guide spectroradiometric measurement 

The short instructions are intended to demonstrate the function of the spectrometer by 
means of an operating sequence. The detailed instructions can be found starting on page 24. 
Please observe the safety instructions in these instructions. 
The goal of the Quick Start Guide is that you end up with a measured spectrum on your 
screen. 

 
1. Start the SRpro program. 

The program starts with a welcome screen and starts the connection to the 
spectrometer. 

 
When starting for the first time, set the user to Power User if necessary. 
See Start > Options > User 
You will find the password as an attachment to these instructions. 

 
2. Check in the main window that the following buttons are active: 

 

Dark measurement (automatic) 

Absolute calibration 

Automatic integration time 
 

3. Hold the diffuser against a light source Start 

the measurement 

A status window is opened. This shows the current integration time 
is output. The integration time is changed several times to achieve a 
modulation of approx. 90%. If the correct integration time is found, the 
window is hidden again and the actual measurement is started. 

4. If necessary, continue with the manual dark 
measurement. Your spectrometer is then ready for 
operation. 

 
Notes for calibrated measurements: 

To perform a calibrated measurement, please select the button " Spectral 
correction relative" or " Spectral correction absolute". The selection of one of 
these two buttons releases the drop-down list for the correction file . 
In this list, select one of the correction files that came with your spectrometer. 
Please note that the file must match the input optics used (fiber optics, U-ball, 
diffuser, etc.). 

 

We recommend the use of dark measurements for absolute irradiance 
measurements, the 
Stray light correction and an averaging over 3 to 20 measurements. 

 

Dark measurement (manual) 

Stray light correction 

Averaging over 3 to 20 
measurements 
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4 Quick guide transmission / reflection measurement 

The short instructions are intended to demonstrate the function of the spectrometer by 
means of an operating sequence. The aim of the short instructions is that you have a 
measured spectrum on your screen at the end. 

 
 

1. Start the SRpro program. 
The program starts with a welcome screen and starts the connection to the 
spectrometer. 

 
When starting for the first time, set the user to Power User if necessary. 
See Start > Options > User 
You will find the password as an attachment to these instructions. 

 
2. Check in the main window that the following buttons are active: 

 

Dark measurement (automatic) 

No calibration 

Transmission measurement / Reflection measurement 

Flash lamp on 

Stray light correction on (only for reflection 
measurements) 

 
 

3. Connect the light guide for transmission or reflection 
 

4. Set the integration time and the number of measurements. Typical: 
a. for transmission measurements e.g. 200 ms and 10 measurements 
b. for reflection measurements with an integrating sphere e.g.30000 ms 

and >3 measurements 
5. Start the measurement Start 
the measurement 

After the dark measurement, which takes a few seconds, you will be prompted to 
to start the 100% measurement (baseline). 

 
6. Then insert the sample (Note Sample measurement). 

 
7. After that, the measurement appears on the screen. 

 
We recommend using dark measurement, stray light correction and averaging over 10 to 100 
measurements. 

 
 

Dark measurement (manual) 

Stray light correction for irradiance and baseline measurements 

Averaging 
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5 Guidelines and standards 
 

The system is a machine according to Annex II A of the Machinery 
Directive and is therefore supplied with a declaration of conformity and 
a CE marking (in accordance with the Machinery Directive). 

 
 

Guidelines 

EU directives 06/42/EC (machinery) (partly applicable) 
2014/30/EC (EMC) 
2014/35/EC (low voltage) 

Harmonized standards 

EN ISO 12100:2010 Safety of machinery - General principles for 
design - Risk assessment and risk reduction 

EN 60204-1:2006 
+A1:2009 
+AC:2010 

Safety of machinery - Electrical equipment of machines 
- Part 1: General requirements 

EN 61000-6-2:2005 Electromagnetic compatibility (EMC) - Part 6-2: 
Generic standards - Immunity for industrial 
environments 

EN 61000-6-4:2007 
+ A1:2011 

Electromagnetic compatibility (EMC) - Part 6-4: Generic 
standards - Emission requirements for industrial 
environments 
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6 Identification 

6.1 manufacturer 
Opsytec Dr. Gröbel GmbH 
Am Hardtwald 6-8 
D - 76275 Ettlingen 
Tel.: +49(0)7243 / 9 47 83-50 
Fax: +49(0)7243 / 9 47 83-65 
info@opsytec.de 
www.opsytec.de 

6.2 Change history 

We reserve the right to make changes to the content. Opsytec Dr. 
Gröbel GmbH is not liable for any errors in this documentation. No 
liability is accepted for indirect damage arising from the supply or use of 
this documentation, to the extent permitted by law. 

 
 

Version Processor Date Change 

1.43 Paravia 15.08.2014 Creation 

1.44 Paravia 10.07.2015 Software update 4.0 

2.0.1 Paravia 21.08.2017 Software update 5.0, pixel count 

2.0.2 Paravia 19.12.2017 Software update 5.1, EXCEL export 
 
 

6.3 Copyright 

Opsytec Dr. Gröbel GmbH shall retain the copyright for this operating 
manual. The operating manual is intended for the owner/operator and 
his personnel. 
Copyright in accordance with DIN ISO 16016: 
Reproduction and copying of this document, use and disclosure of the 
contents in this document are strictly prohibited unless expressly 
authorized. 
Non-compliance may lead to a claim for damages. All rights in the 
case of a patent application, utility model or design are reserved. 
Violations may be subject to criminal prosecution. 

 
6.4 General identifier 

Data for internal use: 
 

Description of the machine: SR900 with SRpro software 

Year of manufacture: …………………….. 

Machine no. …………………….. 

Project no. ……………………... 

http://www.opsytec.de/
http://www.opsytec.de/
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6.5 Terms of use 
 

The system is intended for industrial use only. It is forbidden to use the devices in 
explosive environments or for general illumination 
• Installation, commissioning, operation, maintenance and service work may only be 

carried out by trained and qualified personnel who comply with all safety guidelines 
and standards. 

• Responsibility: Damage resulting from unintentional or unauthorized tampering 
terminates any right to assert warranty or liability claims against the manufacturer. 

• Warranty Disclaimer: The use of any non-original parts will void the warranty. 
• Environmental protection: Defective parts containing substances harmful to the 

environment must be disposed of accordingly. 
• Operation is only permitted in a dry environment. The installation is horizontal. 
• Only suitable for indoor operation. 
• Before opening, the system must be disconnected from the voltage and it must be 

checked that there is no voltage. 
• Wear gloves for servicing, cleaning and replacing the light guides and optical 

components. 
• Do not clean the system when it is in operation. 
• The housing must not be opened by the user. The optically active surface must not be 

touched. 
• Gloves must be worn for cleaning the optically active surface. 
• The SR900 is a highly sensitive optical measuring instrument. It must not be subjected 

to shocks. 
• When using the system, light and UV radiation may be reflected and scattered by the 

measuring head. If necessary, suitable protective measures must be used to protect 
against radiation. 

• Any use other than that mentioned above will result in damage to the product. 
Furthermore, this is related to dangers such as short circuits, fire and electric shock. 
The entire device must not be changed and/or modified! The safety instructions must 
be observed at all times. 

 
6.6 Foreseeable misuse 

The following is considered a foreseeable misuse: 

• Operation of the device without safety devices and safety equipment. 

• Activities of untrained personnel on the equipment. 

• Failure to follow the owner/operator's operating instructions. 

• Ignoring the operating manual. 

• Any use outside the specified purpose. 
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6.7 Legal information 
 

6.7.1 Limitation of Liability 
 

All information in this manual has been compiled taking into account the currently 
applicable standards and regulations, the technical standard and our many years of 
knowledge and experience. 
The manufacturer is not liable for damages in the event that: 

• This manual was ignored, 

• the device has been used improperly, 

• untrained personnel were used, 

• untrained personnel have used the machine incorrectly, 

• inadmissible modifications have been made, 

• technical changes have been made 

• unauthorized spare parts have been used. 
 

We are not liable for common faults of the device caused by a power failure or a failure of 
the control system. 
The actual scope of delivery may differ from the explanations and pictures in this manual 
in the case of special versions, when additional options are ordered, or due to the latest, 
technical changes. 
The obligations agreed in the delivery contract, as well as the manufacturer's delivery 
conditions and the legal regulations valid at the time of the conclusion of the contract shall 
apply. 

 

6.7.2 Conformity of declaration 
 
The declaration of conformity can be found in the appendix or can be requested from the 
manufacturer. 

 

6.7.3 Warranty terms 
 

The warranty conditions are subject to the Civil Code (BGB) of the Federal Republic of 
Germany. The warranty period is 1 year, unless otherwise agreed in the purchase 
documents. 

https://www.gesetze-im-internet.de/bundesrecht/bgb/gesamt.pdf
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7 General 

7.1 Information about this manual 
This manual is intended to make the handling of this system and its components safe and 
efficient. This manual is part of the system and must be kept in its immediate 
environment, where it is accessible to personnel at all times. 
This documentation contains the necessary information for the intended use of the 
system described. It is intended for technically qualified personnel who have been 
specially trained for operation, quality assurance, laboratory, maintenance and repair. 
The personnel must have read this manual carefully and understood its contents before 
starting any work. The basic condition for safe working is the observance of all mentioned 
safety notes and operating instructions in this manual. 
Knowledge and technically correct implementation of the instructions, safety requirements 
and warnings are a condition for safety during operation, maintenance and repair. Only 
qualified personnel have the necessary expertise to apply the safety instructions, safety 
requirements and warnings mentioned in this operating manual in a general way in a 
specific situation. 
In addition, the local accident prevention regulations and the general safety regulations 
for the area of application of the system apply. 
Illustrations in this manual are for general understanding; they may differ from the actual 
version. 
Apart from this manual, the instructions for the installed components contained in the 
appendix apply. 
This operating manual cannot cover every possible maintenance case. If you require 
further information or if special problems occur which are not covered comprehensively 
enough in this manual, please request the necessary information from the manufacturer. 

 
 
 
 

For ease of description, the above components are 
collectively referred to as the system. 
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7.2 Information about the symbols 
7.2.1 Safety instructions 

 
In this manual, safety instructions are represented by symbols. The safety instructions are 
preceded by signal words indicating the extent of the danger. 
To avoid accidents and damage to persons or property, always follow the information and 
act prudently. 
Throughout the text you will find the following pictograms  with the 
following meanings: 

 
 

 

 

 DANGER 

Imminent danger 
Possible consequences: Death or most severe injuries. 

• Prevention 
 
 

 

 

 WARNING 

Dangerous situation 
Possible consequences: Death or most severe injuries. 

• Prevention 
 
 

 
 

 

 CAUTION 

Possible situation 
Possible consequences: Minor or slight injury. Sometimes also 
used as a warning of material damage. 

• Prevention 
 
 
 

Note 
Information about the application or useful, important information 

 
 
 

7.2.2 Prohibition signs 
 
 

General "prohibition sign 
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7.2.3 Warning signs 
 
 
 

 

Warning against optical radiation 
(such as UV, IR or visible radiation). 

  
Warning against electricity! 

 
 
 
 

7.2.4 Attention 
 
 
 

Wear eye protection! 

 
 

Disconnect the mains plug from the socket! 

 

Disconnect before performing maintenance or repair! 

 
 

Wear hand protection! 

 
 

Refer to the instructions! 
 
 
 

7.2.5 Optional function 
 

* Optional function, 
not available for every system. 
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7.3 owner/operator information 
The system is used on the commercial environment. The owner/operator of the system is 
therefore subject to the legal obligations regarding occupational safety. 
In addition to the safety information in this manual, the generally applicable regulations 
valid for the area of application of the system with regard to safety, prevention of 
accidents and protection of the environment must be observed and complied with. 
The following applies in particular: 

The owner/operator must acquire information about the valid occupational health and 
safety regulations and determine in a risk assessment additional hazards that have 
arisen due to the special operating conditions at the place of use of the system. He 
must implement these in the form of the operating instructions for the operation of the 
system and specifically for the individual workstations. 
The owner/operator is required throughout the life of the system to verify that the 
operating instructions it has developed are in compliance with the current regulatory 
status and must update them as necessary. 
The owner/operator must clearly assign and define responsibilities for 
installation/operation, troubleshooting, service and cleaning. 
The owner/operator must ensure that all personnel dealing with the system have read 
and understood this manual. Furthermore, he is obliged to offer personnel training at 
regular intervals and to provide information about the risks and hazards. 
The owner/operator must provide the required personal protection equipment for his 
personnel. Furthermore, the owner/operator is responsible for ensuring that the system 
is always in a faultless technical condition. To ensure this, the service intervals 
specified in this manual and in the technical documents for the individual system must 
be observed and all safety installations must be regularly checked for function and 
completeness. 
The owner/operator must regularly check all safety devices for function and 
completeness. 
The owner/operator must ensure that the operating personnel have knowledge of first 
aid measures and the local rescue equipment. 
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7.4 Personnel requirements 
7.4.1 Qualifications 

 
Below, the manual lists the personnel qualifications for the various areas of activity: 

7.4.1.1 Qualified electrician 
Based on their training, competence, experience and knowledge of the relevant standards 
and regulations, qualified electricians perform work on the electrical equipment and 
independently identify and avoid risks. 
Qualified electricians are specially trained for the working environment in which they work 
and they know the relevant standards and regulations. Qualified electricians must meet 
the requirements of the applicable legal regulations for accident prevention. 

7.4.1.2 Qualified specialist 
Qualified specialists are or can be trained by Opsytec Dr. Gröbel GmbH in the advanced 
operation and parameterization of the system, as well as in the performance of preventive 
service work. 
In addition to their technical training, competence and experience, as well as their 
knowledge of the relevant standards and regulations, they are able to carry out the work 
assigned to them and independently recognize and avoid possible hazards. 

7.4.1.3 Operator 
Operators use and operate the system within the scope of its intended use. They are 
trained by the owner/operator in the work assigned to them and informed about possible 
hazards. 

 

7.4.2 Training and qualification of personnel 
 

In regular instructions and training, the operating personnel must be informed about the 
special risks and dangers when working with and handling the system. 
The instruction and training should have the following content: 

Hazards when working with the system in normal operation. 

Hazards associated with service, repair and cleaning activities. Behavior to 
minimize accident consequences. 
Behavior in case of accidents. 
Rescue of injured persons. 
Working without personal protective equipment can cause damage to health. The 
company supervisor is instructed to ensure that the personnel wear personal 
protective equipment. 
Special hazards when working on electrical equipment. 

 
The instructions and training must be carried out at regular intervals by the 
owner/operator. For better tracking, the implementation of the instruction and training 
should be recorded. 
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7.4.3 Personal protective equipment 
 

The purpose of personal protective equipment is to protect personnel from hazards that 
could affect their safety or health at work. 
When performing various activities on and with the system, the personnel must wear 
personal protective equipment. This is repeatedly referred to in the individual chapters of 
this manual. The personal protective equipment is explained below: 

 

7.4.3.1 Protective gloves 
Protective gloves are used to protect hands from visible and/or invisible radiation, friction, 
abrasions, stings and deep injuries. 

 

7.4.3.2 Safety goggles 
Safety glasses are used to protect the eyes from visible and/or invisible. 

 

7.4.3.3 Safety shoes 
Safety shoes are worn as protection from heavy parts that could fall and from slipping on 
slippery surfaces. 



8 Safety instructions and residual 
 

17 
 

8 Safety instructions and residual risk 

8.1 Gerneral 
The system is state of the art and has been built in accordance with recognized safety 
regulations. Nevertheless, its use may pose risks to the life and extremities of the 
operating and repair personnel (service personnel) or third parties, or impair the machine. 
Operate the system only when its safety devices are in perfect condition. Malfunctions 
that impair their safety must be rectified immediately. 
The following safety information must be strictly observed to avoid damage to the 
machine and personal injury! 
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8.2 Safety instructions relating to normal operation 
 
 

 
 

 

 CAUTION 

Risk of damage 
• The SR900 is calibrated. Do not subject the device to shock. 
• CAUTION: Opening the housing will result in loss of 

calibration. 

 
 

 
 
 

 

 CAUTION 

Risk of damage 
• Skin grease and dirt are absorbent in the UV and visible spectral 

range. 
• Avoid fingerprints on the optically active sensor surface. 

If necessary, clean the components carefully with 
isopropanol. 

 
 

 
 
 
 
 

 

 CAUTION 

Risk of damage 
Special guidelines must be followed when using an optical fiber. 
Avoid: 
• Touching the end faces with the fingers 
• Storage on dusty surfaces 
• Bumping against hard surfaces 
• Immersion in e.g. contaminated liquids. 
• small bending radii (200mm) 

 
 

 

 

 CAUTION 

Risk of damage 
• Hand-tighten the knurled screws of the SMA-905 light guides. 

 
 

 
 
 

 

 WARNING 

Fire hazard! 
A high irradiance, which can ignite combustible materials in case of 
continuous irradiation, is achieved at the output of the light guide of 
optional flash lamps. Remove all combustible materials and observe 
the irradiation time and material temperature. 

The wearing of personal protective equipment (e.g. safety goggles and hand protection) is 
mandatory when working on the system. 
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8.3 Radiation safety 
 

 
 
 
 
 
 
 
 
 

 

 WARNING 
Risk of eye injury 
The SR900 can be optionally equipped with xenon flash lamps. There is then a 
risk of photochemical or thermal damage to the eye, retinal damage and burns. 
Visible (blue) light can cause photochemical damage to the eye. If necessary, 
use suitable protective goggles when operating the unit. The operating 
personnel must be trained appropriately. 
Recommended protective equipment: 

- Gloves 
- Safety glasses, no transmission below 400 nm 

 

Do not look into the light source and do not expose skin to the 
radiation! Avoid reflections of the radiation into the eye! 
The system should be  designed in such a waythat a direct  view 
into the light guide receptacles and the light guides is prevented. 
The devices have been classified in risk group 3 according to DIN EN 
62471:2009-03 
"Photobiological safety of lamps and lamp systems" classified. 

 
The risk assessment for the workplace is the responsibility of the customer. This requires 
measurements / assessments according to DIN EN 14255-1:2005-06 "Measurement and 
assessment of personal exposure to incoherent optical radiation - Part 1: Ultraviolet radiation 
emitted by artificial sources at the workplace". 
DIN 14255-1 itself does not contain any limit values. These are given in Directive "2006/25/EC 
of the European Parliament and of the Council on the minimum health and safety requirements 
regarding the exposure of workers to the risks arising from physical agents (artificial optical 
radiation)". 
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8.4 Safety instructions relating to service and repair work 
 
 

 

 

 WARNING 

Risk of injury when touching live parts 
Before opening the system, disconnect all components from the 
supply voltage and check that no voltage is present. 

 
 

 
 

 

 CAUTION 

Risk of damage 
• The SR900 is calibrated. Do not subject the device to shock. 
• CAUTION: Opening the housing will result in loss of 

calibration. 

 
 

 
 
 

 

 CAUTION 

Risk of damage 
• Skin grease and dirt are absorbent in the UV and visible spectral 

range. 
• Avoid fingerprints on the optically active sensor surface. 

If necessary, clean the components carefully with 
isopropanol. 

 
 

 
 
 
 
 

 

 CAUTION 

Risk of damage 
Special guidelines must be followed when using an optical fiber. 
Avoid: 
• Touching the end faces with the fingers 
• Storage on dusty surfaces 
• Bumping against hard surfaces 
• Immersion in e.g. contaminated liquids. 
• small bending radii (200mm) 

 
 

 

 

 CAUTION 

Risk of damage 
• Hand-tighten the knurled screws of the SMA-905 light guides. 

 
 

Service, repair and cleaning work may only be carried out by authorized and specially 
trained personnel. The system must be de-energized and secured before major work 
(including cleaning) is performed). 
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Carry out the prescribed adjustment, service and inspection work in accordance with 
the instructions. If you require further information in this connection, or if special 
problems arise which are not dealt with comprehensively enough in this manual, 
please request the necessary information from the manufacturer. 
The housing must not be opened by the user. The optically active surface must not be 
touched. 
Gloves must be worn for cleaning the optically active surface. 
The SR900 is a highly sensitive optical measuring instrument. It must not be subjected 
to shocks. 
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9 Description of the system and function overview 

The compact SR900 spectroradiometer is a high-resolution measuring system for fast 
and precise measurements in the UV, visible spectral range and IR. The measuring range 
extends from 200 nm to 1100 nm. The spectroradiometer consists of an array 
spectrometer without moving parts and a silicon array with 2048 pixels. The spectral 
resolution is 2.3 nm (pixel pitch 0.4 nm). The SR900 is combined with an SMA-905 quartz 
optical fiber and our radiometric probes for irradiance and illuminance measurements. 
With trigger input and output, the SR900 is also suitable for automated measurements. 
The SR900 is traceable to the PTB factory calibrated. DAkkS testing in our accredited 
laboratory is optionally available. The SR900 thus allows accurate spectroradiometric 
measurements for the evaluation of irradiances and illuminances, biological efficacy and 
color measurements. Due to the low stray light design, high sensitivity in the UV range is 
achieved. Control and data evaluation are performed with the spectral software SRpro. 
For the SR900, we also carry an extensive range of accessories, which can be combined 
with customer-specific extensions. 
With version 4.0 we already introduced an extended user administration. This makes it 
possible to switch the user interface permanently between a main user, with all functions, 
and a restricted user. A password is required for the switchover, which is included in this 
documentation. It is therefore possible to use the SR900 in a qualified environment. 

 
The user rights differ as follows: 

 

Right User Main user 

Carrying out measurements yes yes 

Change settings that affect the 
Influence measurement result (see below) no yes 

Manually changing the integration time yes yes 

Change calibration no yes 

Saving faulty measurements (as pdf) 
(see Threshold settings). no yes 

Automatic save as pdf yes no 

Evaluation included in the protocol (pdf) yes no 

Manipulation of measurements / 
Measurement calculations no yes 

Change user permanently no yes 

Change password no no 
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For example, the restricted user is not able to change the following settings: 
- Change printer settings and log settings 
- Change dynamic measurement 
- Change spectral correction off / relative / absolute 
- Change correction file 
- Change offset correction 
- Change dark measurement 
- Perform data manipulation 
- Accidentally overwrite files 

 
 

9.1 General product description: 
 

• Spectral range 200-1100 nm 
• Low stray light grating with 300 lines/mm 
• 1.4 nm bandwidth 
• Order filtering 
• Spectral software for color measurement, radiometric and effect-related measurements 
• Simple validation through user concept 
• Extensive range of accessories 

 
 
 

9.2 The following components are supplied: 
 

• Spectroradiometer SR900 
• Spectrometer software SRpro 
• USB cable 
• this documentation 
• optional: fiber optic cable 
• optional: sensor head 
• optional: integrating sphere reflection attachment 

 
 

For ease of description, the above components are 
collectively referred to as the system. 

 
 

The following components are required by the customer: 
 

• PC with Windows 7 / 10 
• Free USB interface 
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10 Commissioning 

• Unpack all components and remove the packing materials. 
 
 

 
 

 

 WARNING 

Risk of damage 
The light conductors are very sensitive and must not be bent or severely 
bent. 
A minimum bending radius of 200 mm must be observed. 

 

10.1 Software installation 
- Connect the USB stick or CD to the PC and double-click Setup.exe. 
- Follow the installation instructions on the screen and confirm the installation of the 

drivers. 
 
 

10.2 Removing SR900 
If necessary, you can remove SR900 from your computer. You can do 
this in the following ways: 

- Click on "Start" in the Windows Start menu and select "Programs > SRpro > 
Remove SRpro". 

- Select "Settings > Control Panel" in the Windows "Start" menu. Double-click 
-        on"Software"in the 

control panelSelectSRpro in the dialog box. 
-     Software Properties"on 

the tab page 
     
 Install/Uninstall"and click the button 
"Add/Remove". 

 
 
 

10.3 Installing device drivers under Windows 8 
 

In Windows 8, it is no longer possible to install unsigned drivers by default. However, 
you can allow unsigned drivers. 
This tutorial shows how this can be done. 

- Key +i 
- Press and hold the Shift key and click Restart. Do not release the Shift key until 

the following screen appears. 
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- Now click on Troubleshoot 
 

 
- And then click on Advanced Options 

 

 
- Then click on Startup Settings 

 

 
- Click on "Restart" in the subsequent message. 
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- The computer will then restart. 
- When restarting, the startup settings appear 

 

 
- Now allow the unsigned drivers with the number key 7 or the function key F7. 

Windows is then started. 
- During the installation of the driver, a prompt will now appear. Press "Install this 

driver software anyway". 
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11 Software operation 

11.1 The controls 
The operating elements are labeled in the following figure. In the following, the individual operating 
elements are presented in detail and their function is explained. 

 

Menu bar Toolbar 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Info area 

 
Status bar 

 

Spectral diagram 
 

11.2 The spectral diagram 
At the top left of the screen you can see the units, at the bottom right the level. The largest 
part of the screen is the graphical representation of the spectrum.  In horizontal direction the 
wavelength is displayed, in nm and in vertical direction the spectral irradiance. 
The lower part of the screen contains the display of the current cursor position and the 
controls for managing multiple spectra. 

 

By clicking and holding the left mouse button, a rubber band can be drawn. The section when 
releasing the left mouse button is zoomed out and displayed enlarged in the spectral window. 
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Pan function 
The Pan function is used to move the graphic. To activate the pan function, the CTRL key must 
be held. When the mouse pointer is in the graphic, it changes the shape to a cross. Now the 
graphic can be moved by pressing and holding the left mouse button. 
Context menu of the spectral window 
Clicking the right mouse button within the graphic opens the context menu. 

 
 

Under Zoom Auto. Scale can be switched on/off, return to the full range or display the ordinate 
10% or 20% larger than the maximum signal. 

 
If the menu item "Scan graph" is selected, a crosshair is displayed as soon as the mouse is in 
the spectral display. This crosshair follows the mouse movement and is always assigned to the 
wavelength of the mouse position. 

 
Under the item "Edit" the spectral graph can be copied to the clipboard or saved as a bitmap 
file. Using these functions, it is possible to transfer the spectral display to a word processing 
program for documentation purposes. 

 
The bottom item "Start measurement" starts a new measurement. 
If the menu item "Scan graph" is selected, a crosshair is displayed as soon as the mouse is in 
the spectral display. This crosshair follows the mouse movement and is always assigned to the 
wavelength of the mouse position. 

 
Under the item "Edit" the spectral graph can be copied to the clipboard or saved as a bitmap 
file. Using these functions, it is possible to transfer the spectral display to a word processing 
program for documentation purposes. With the function "Copy data to clipboard" the 
measurement data are comfortably available for a spreadsheet. 
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11.3 Working with multiple spectra 
The SRpro software offers the possibility to display several spectra simultaneously. The current spectrum 
is always displayed with thicker lines. Bottom right appears 

 
 

Selection of the active spectrum 

Click on the expand the list of open spectra. 
 

Figure 1: Selection list for active spectrum 
Select a spectrum from the list and click on the name. This spectrum is now 
taken over as the current spectrum. All displays, such as integral values and 
weights, are now displayed from this spectrum 

 
 

‚  
Delete a spectrum 
To delete a spectrum, select the spectrum as the active spectrum. Now press 
the button to the left of the name. This will delete the active spectrum from the 
memory. 

 
 

11.4 Symbol overview 
The toolbars provide grouped, context-dependent access to the most important functions. The toolbar 
is the central control element for performing a measurement. Example: 

 

 
It is important to know about the functions of each switch and to check the correct setting before performing 
a measurement. 

 
 
 

Open spectrum 
Files from previous measurements can be selected and the spectra displayed 

on the screen. 

 
 

Save automatically 
All measurements can be saved automatically. The file name is given a three-
digit number at the end, which is increased by one for each measurement. So 
names like test001, test002, ... are possible. 
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Save spectrum 
Only one measurement will be saved by entering a name. 

 
Export spectrum 
It will save the measurement as an EXCEL file of the CSV file. See options 

Print 
Here the spectrum is printed. After the spectral diagram, the comment from 
the info window and the settings during the measurement are printed. The 
values from the displayed evaluation window (integration, weightings and 
color measurement) are also printed. 

Set printer 
Calls the "Set up protocol" dialog. There you have the possibility to customize 
the content of the PDF export. You can find an example protocol in the 
Appendix. 

 
 

PDF Export 
Saves the print output in a pdf. The included evaluations and data can be 
configured via the printer settings. 
A sample protocol can be found in the appendix. 

 
 

Integration time 
In this input window the integration time is set in milliseconds. Depending on 
the computer speed, the smallest possible value is 30 ms. If the spectrum is 
displayed incorrectly, the computer speed is too low for the integration time. 
Then select a longer integration time. 
With uncooled array the maximum reasonable integration time is between 
30000 and 60000 ms. With cooled array 60000 ms are always possible. Here 
the value Amax right under the spectrum window should be between 50% and 
just under 100%, otherwise the integration time should be changed. 

 
 

Start measurement 
Starts a new measurement with the set parameters. 

 
 

Dark measurement on/off 
Here you select whether the dark signal is to be determined before each 
measurement in a dark measurement with the same integration time and 
subtracted from the light measurement. Each photodiode array has a 
temperature-dependent dark current. This means that the photodiodes show 
a value greater than zero at large integration times, even at complete 
darkening. This effect can be fully compensated by subtracting a dark 
measurement from the measurement signal. We recommend, except for test 
measurements, to always switch on this item. 

 
 

Continuous measurement on/off 
With the parameters set, the measurements are made as fast as possible one 
after the other (i.e. as fast as the computer speed allows). 
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allows). In order to make a defined pause between two measurements, a 
corresponding time can be set in the "Settings->Device options" menu in the 
"Measurement interval" tab. With automatic save on, the number at the end 
of the file name is incremented. In the upper line a button "Stop" appears on 
the right, with which one ends the continuous measurement. 

 
 

Automatic integration time on/off 
The button is used to determine whether the integration time should be 
determined automatically. If the button is pressed, the program will increase 
the integration time until the largest value of the spectrum between 80 and 90 
% lies. 

In the case of radiation sources operated with AC voltage, beatings can occur 
with the measurement time determined in this way, since parts of the period 
duration are not completely recorded. In this case, an integration time should 
be selected which is a multiple of the period duration. 

 
 

Transmission reflection measurement on/off 
Both transmission measurements and reflection measurements can be 
performed. For this purpose, two spectral images are taken in each case: first 
the measurement of the radiation source, then the measurement with 
specimen. For the reflection measurement, a reference standard is inserted 
during the measurement of the radiation source. 
Note that the division only produces meaningful values if the lamp also emits 
radiation in the corresponding spectral range. The noise increases strongly 
with decreasing intensity. 

 
For transmission and reflectance measurements, a baseline and dark 
measurement must be performed. These measurements must be repeated 
when changing the integration time, the number of averages or changing the 
light guide. 

 
For the same measurements, the 100% measurement (baseline) and the dark 
measurement can be saved automatically, so that they are not 
have to be performed again. Consequently, the measurement is faster. 
To do this, select in the menu Settings 

 
Baseline correction and USE 
Correct for dark 

 
 

Dynamic measurement on/off* 
The button "Dynamic measurement" determines whether several 
measurements are performed to improve the dynamics. If the button is 
pressed, 3 measurements are performed. The first measurement with the 
normal integration time, the second measurement with the 5-fold integration 
time and the last measurement with the 25-fold integration time. 
Subsequently, a spectrum is assembled from the three measurements. 

The measurements with multiple integration time are divided by a previously 
determined correction value. All values of a spectrum with increased 
integration time, which are smaller than 90% of the saturation value, are 
divided by the determined correction value and then fed to the further 
calculation. 
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Figure 2: The calculation of the dynamic spectrum 

 
 

Averages 
In the Averaging window, the number of averages performed during a 
measurement is specified. Averaging over several measurements can 
improve the signal-to-noise ratio. The value for averaging can be between 1 
and 65000. However, values between 10 and 100 are realistic in order not to 
make the total measurement time too long. If the value 1 is entered as the 
averaging number, no averaging is performed. 

 
 

Flash on/off (not available on all spectrometers)*. 
By means of the switch Flash you determine whether trigger pulses are to be 
given to the output Flash during the measurement. The number of flashes 
depends on the integration time. The flash signals have a frequency of 100 
Hz. 

 
 

External triggering* on/off 
After starting the measurement via "  Start measurement" the following 
status window is displayed. 

 

Figure: Waiting for external trigger 
The activated trigger input is now monitored. As soon as the trigger signal 
comes, the measurement is started. If both trigger inputs are activated, the 
evaluation will show a logical 
"or" link between the two inputs is performed. 

 
 

Spectral correction off 
The spectrum is referred to the level of the A/D converter. 100% means full 
modulation of the A/D converter. As soon as the A/D converter has full 
modulation at a point, the value of the spectrum is set to 100% at this point. 

dynamic 
spectra 

spectra 
tIx1 

spectra 
tIx5 

spectra 
tIx25 

  

spectra 
/ D1 

spectra 
/ D2 
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Spectral correction relative 
The sensitivity of the spectrometer is not constant over the wavelength. This 
is due to the diffraction characteristic of the diffraction grating, the spectral 
sensitivity of silicon and the sensitivity differences of the individual 
photodiodes. Furthermore, the spectral response of the light guide and the 
other input optics used enters here. This wavelength dependence is 
compensated by assigning a correction value to each photodiode. Each 
measured value is multiplied by a correction factor. Thus, the calculation of 
color coordinates, color rendering indices and color temperature becomes 
meaningful. 

 
 

Spectral correction absolute 
The spectrum is given in physical units, e.g. µW/(cm nm) from this further 
quantities are calculated, e.g. irradiances & illuminances. At saturation, the 
values jump to the largest value of the spectrum that is not yet in saturation. 

 
 

Correction file 
     The correction file used is displayed in the window. It must always be the 

file that belongs to the input optics used. 
 
 

Stray light correction 
From the measured spectrum you can subtract the offset that was determined 
in a certain wavelength range. To do this, enter the cutoff wavelengths of the 
range in which you want to determine the stray light component in the 
window. The stray light correction may be activated only if you know from a 
radiator that it has no signal in a certain range. During the later measurement, 
the average value that results in this range is subtracted from the 
measurement. 

After entering the wavelength range for the stray light correction, an offset 
correction factor can be specified. This factor is used to multiply the stray light 
offset before it is subtracted from the spectrum. The default value for the 
offset correction factor is 1. 
Stray light arises from diffraction at the entrance slit, from grating defects, 
from the 0th diffraction order at the grating, as well as all diffraction orders 
except the 1st order incident on the array, and finally from reflections at the 
array, window, and filter in front of the array. 

 
 

Calculator & Data Manipulation 
With this function you can manipulate the spectra. The basic arithmetic 
operations are possible. It is also possible to manipulate with constants. 
Constants are entered in the left under two input windows in the 
"Mathematics" window. If the result is to be displayed as a new spectrum, the 
name is entered in the lower right input window. 
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Figure: The math window for data manipulation 

Please note that the spectra to be used must be displayed as marked in the 
figure. If they are only marked with a frame, the program does not recognize 
this selection. A corresponding message will be displayed. 

 
 

Information about current spectrum 
The instrument settings for the measurement appear in the information 
window. In addition, text lines for further information can be entered. The 
contents of this window are always output when printing. 

 
 

Integral 
Irradiance values can be calculated under "Settings -> Evaluations". 

 
 

Weightings 
    Weighted 
irradiances can  be calculated   
  under"Settings->  Evaluations". 

 
 
 

Color coordinates 
The values specified in "Settings -> Evaluations" tab Colors are calculated and 
output. 

Window settings color 
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Viewer 
The standard observer is set 2° or 10° according to the CIE. 

 
 
 

Color rendering indices 
If the color measurement is switched on, the color rendering indices can 
 be calculated and output.  Only 
the color values specified in 
"Settings -> Evaluations" tab colors specified values are output. 

 

Color triangle 
If the color measurement is switched on, the position of the color location in 
the CIE 1931, CIE 1960 or CIE 1976 color triangle can be displayed in the 
corresponding color triangle. 

 



11 Operation 36 
 

11.5 File menu 
Other settings are available via the menu that have not already been described as an icon. The menu is 
shown below: 

 
 

 
It is possible to save and load an existing settings file. In a settings file (*.ssf), all settings such as 
integration time, averaging, dark measurement, integration ranges, etc. are saved. The use of settings 
files is especially useful if you have to perform different measurements again and again. 

 
Switching the program language is possible between German and English. After the language change, 
all menu items are displayed in the new language and this is permanently saved. 

 
 

11.6 Window menu 
Other settings are available via the menu that have not already been described as an icon. The menu is 
shown below: 

 
 

 
The menu items in detail: 

 

If this function is checked, the graph will be adjusted each time it is 
redrawn to make maximum use of the spectral graph. 

Zooms into the predefinable areas 

If this function is selected, the ordinate of the graph is scaled 
logarithmically. 
Displays the CIE color triangles 

 
 
 
 

11.7 Analysis menu 
Other settings are available via the menu that have not already been described as an icon. The menu is 
shown below: 

 
 

 
The "Analysis" item opens an options window. In this the 
evaluation of the spectra can be made. 
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The start and end wavelengths of the display are defined under the "Spectrum" tab. The unit to be 
displayed can be selected here and will be converted automatically. "Fill Graph" fills the area under 
the spectrum in the output. 

 
 

In the "Irradiances" tab, you can switch the calculation of the standard integrals on or off. Also a 
calibration of the integral is possible. 
Furthermore, 4 user integrals are available. As soon as you switch on a user integral, the 
calibration factor and the start and end wavelength of the integral are enabled. 

 
 

 
 

In the "Weighted irradiances" tab, the LUX (V(Lambda), erythema weighting and 
pigment weighting are provided by default. 
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User weighting files can be selected for User1 to User4. These files must exist in the WEIGHTS directory 
and have the file extension GEW. If a user weighting is switched on, the existing weightings are displayed 
in the corresponding file selection list. The weighting file has the following structure: 

 
The weighting files are ASCII files that represent the weights in real format followed by a [CR] 
character. The weights start at 
200nm and end at 800nm. The step size between the individual values is 0.6nm. e.g. 

[Real value] [CR] 6.0754321E-002 
[Real value] [CR] 5.3765211E-002 
. . 
. . 
[Real value] [CR] 1.5987988E+001 

 
The file names ERYTHEM.GEW , LUX.GEW and PIGMENT.GEW are standard 
weightings For the user functions any designations (e.g. USER1.GEW - 
USER4.GEW ) are available. 

 
 

The "Color" tab allows to show/hide color relevant calculation data (color coordinates, color 
temperature, distance from the Planck train for the 2 degree and the 10 degree observer 
respectively). 
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In the "Wavelength" tab, you can display the peak wavelength, the dominant 
wavelength and the centroid wavelength. 
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11.8 Options menu 
Other settings are available via the menu that have not already been described as an icon. The menu 
is shown below: 

 
 

 
After clicking on "Options" a window is opened which contains further 
tabs. These tabs can be used to define device settings. 

 
 

The "Path" tab can define the directories to the files used. These directories are created and entered 
during the installation. However, if you have different directories, the change is possible here. 

 
The "Measurement" tab allows to change the pause between two measurements in case of 
continuous measurement. If the check mark is removed, you can change the pause between two 
measurements between 1 and 300 seconds using the slider. 
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In addition, the baseline (for 100%) and the dark measurement can be saved for transmission and 
reflection measurement so that the same settings do not have to be measured again. To do this, select 
"Create baseline ..." and "Use" respectively 

 
The stray light correction is selected via "Manual Range" or Auto. In the manual range, an offset 
determined in a certain wavelength range can be subtracted from the measured spectrum. To do this, 
enter the cutoff wavelengths of the range in which you want to determine the stray light component in 
the menu. The stray light correction may only be activated if you know from a radiator that it has no 
signal in a certain range. During the later measurement, the average value that results in this range is 
subtracted from the measurement. 
After entering the wavelength range for the stray light correction, an offset correction factor can be 
specified. The stray light offset is multiplied by this factor before it is subtracted from the spectrum. The 
default value for the offset correction factor is 1. 
Stray light arises from diffraction at the entrance slit, from grating defects, from the 0th diffraction 
order at the grating, as well as all diffraction orders except the 1st order incident on the array, and 
finally from reflections at the array, window, and filter in front of the array. 

 
 

The "Auto" option corrects the stray light by evaluating and subtracting the first pixel. 
 
 
 

General settings can be made in the "Settings" tab. For example, the start screen can be hidden or 
the search for the spectrometer at program start can be prevented. Also the possibility to output a 
sound after the end of a measurement can be switched on here. 

 

 
In the "Threshold" tab, how to define the range of a valid measurement based on the level. If the 
level of the measurement is within the thresholds, the measurement is evaluated as OK in the PDF 
protocol for (standard) users. Note: For power users there is no evaluation. 

 
Recommended settings: 30% to 90% 
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In the "Users" tab, it is possible to switch between the restricted (default) user and the main user 
once or permanently. 

 
Enter the password for the main user and confirm with "Save user" to activate the main user 
permanently, i.e. at every system start. 

 
Note: The default setting is restricted user. For one-time setting changes, it is sufficient to enter the 
password. In this case, do not click on "Save user". 
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In the "Export" tab, the export function can be parameterized. Available are: 
- The wavelength range 
- The interpolation distance (interpolation points) 
- The path 
- File format. 

 
Note: Microsoft EXCEL 2010 must be installed for EXCEL export. 
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11.9 Edit menu 
Under the item "Edit" the spectral graph can be copied to the clipboard or saved as a bitmap file. 
Using these functions, it is possible to transfer the spectral display to a word processing program for 
documentation purposes. With the function "Copy data to clipboard" the measurement data are 
comfortably available for a spreadsheet. 
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11.10 Calibration menu* 
With the delivery of the spectrometer you will receive the calibration file as well as a calibration 
certificate. This calibration data must be transferred to the software in order to obtain an exact 
measurement. 

 
It is nevertheless possible to calibrate the spectrometer itself to absolute irradiances via the 
"Calibration" menu item. A relative display of the spectra is still possible despite absolute calibration. 
The setting of the desired correction type is done via the toolbars. The spectrometer is calibrated at 
delivery. To increase the accuracy of the measurement result, the program has the possibility to 
perform its own calibration. For this purpose, a standard lamp or two standard lamps with spectral 
characteristics guaranteed by the manufacturer are required. The calibration is performed by default 
in the range of 
360-800nm with a halogen lamp and in the range of 200-360 nm with a deuterium lamp. If only one 
measuring range is required, a partial calibration can also be performed. In this case, the calibration 
of the other range remains active. The link point at which the two partial calibrations are joined can 
be shifted from 360 nm to any position in the spectral range. The calibration procedure for a range is 
described below. 

 
                      After calling up the menu item "Calibration", a security query is first carried 

out. 
 

This safety query is performed because an accidental change of the calibration values is not reversible 
when the subsequent window is closed with "Next". A calibration measurement cannot be reversed 
under any circumstances. 

 
If an existing calibration file is overwritten by the calibration measurement, this is not 
reversible. 
If you do not have the equipment (measured calibration lamp, deuterium lamp, ...) for the calibration, 
please cancel the confirmation prompt with the "Cancel" key. 

 
After the security prompt, you are in the "Serial number" tab. Enter the serial number of your device 
here. You will find the serial number on the back of the device. As soon as you have entered the serial 
number, a check is made in the parameter files to see whether your device has already been 
registered. If this is not the case, a corresponding message will be displayed and you can register your 
device again. If your device is already in the list, the settings for your device are loaded. 
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Now switch to the "Shift" tab. 
In the "Displacement" tab you have two setting options: 

• Start diode: 
By changing the start diode number, the position of the spectrum is changed. A 
fine calibration of the wavelength assignment is possible via this value. 

• Dispersion: 
Dispersion sets the spread of the spectrum. This value also influences the 
wavelength assignment. 

Only change both values with the greatest care. Make a note of the set values before changing them. 
After making changes, always take measurements again and evaluate the result. Please note that the 
window is not displayed modally. I.e. you can use the "Start measurement" icon of the main window at 
any time without closing the window. 
The mercury lines at 253.6 nm, 577.0 nm and 579.0 nm are well suited for setting the start diode 
number and dispersion. With a successive change of start diode number and dispersion, very good 
values can be achieved. 

 
When you are satisfied with the wavelength assignment, please switch to the "Spectral Response" tab. 
Course" tab. 

In the register "spec. Course" the spectral sensitivity of the receiver is corrected. The calibration 
lamps are required for this. The register has the following setting options: 

 
• Connection wavelength: 

The linking point of the two partial calibrations can be set here. 
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• Unit: 
Here the unit can be changed. This function allows, for example, to change the 
calibration to Anglo-Saxon units of measurement. 

 
• Norm file for the upper area: 

File name of the standard file for the range from the link wavelength to 800nm. 
The structure and generation of the standard file is explained in chapter 11.11. 

 
• Norm file for the lower area: 

File name of the standard file for the range from 200nm to the link wavelength. 
The structure and generation of the standard file is described in chapter 
11.11 explained. 

 
Target file: 
The file name for the calibration file to be created can be specified here. Please check if the file already 
exists. If necessary, use date coding in the file name to avoid accidentally overwriting an existing 
calibration file. 

 
The actual calibration measurement is started with the "Calibration" button. The parameters of the 
measurement are taken over from the main window. First, it is checked whether the target file already 
exists. If it is available, it will be loaded. This serves for the fact that with partial calibrations 
automatically the other partial range is taken over. If the target file is not available, the following 
message is displayed. 

 

 
The target file is then recreated and all values are set to zero. The query for the upper spectral range 
then takes place. If the calibration measurement for the upper spectral range is to be skipped, this can 
be done by pressing the "Cancel" key. 

 

After confirming with "OK", the correction measurement for the upper spectral range is performed. The 
calibration file is then calculated from the raw data in such a way that the raw data multiplied by the 
calibration file results in the standard file for the upper spectral range. Values in the calibration file that 
are below the link wavelength are not changed by this process. 
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Subsequently, the measurement for the lower spectral range takes place. After the measurement, the 
values are adjusted so that the correct measured value is present at the connection wavelength. 

 

After calibration has been completed, switch to the "Absolute Intensity" tab. 
 

In the "Absolute Intensity" tab, you can correct the absolute intensity. This may be necessary if you 
have been given the absolute intensities and the irradiance at a certain distance for your calibration 
lamp but have not carried out the calibration at this distance. Then you can e.g. determine the 
irradiance ratio between target and actual irradiance at the nominal position and calculate it into the 
correction file with the button "Perform correction". The target file from the "Spectral course" tab is used 
as the correction file. Course" tab is used as the correction file. 

 

10.8 Handling and saving the calibration files 
 Tocomplete the transfer of the calibration , the calibration files must be 
transferred. 

 
 

With the delivery you will also receive the calibration files. These calibration files (*.SpecCal) must be 
copied into the corresponding directory (default: C:\ProgramData\SR900 \SpecCal). Use the 
Windows Explorer for this purpose. 

 
If this path does not exist on your computer, you can change it in the menu item "Settings - 
> Device options" tab sheet "Directories" look up the path for the calibration files. 
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Please copy the calibration files, then into the appropriate directory. 
 
 

If protection against accidental manipulation or handling of user rights is 
desired, change the Windows security settings to "Deny folder contents", 
as shown below as an example: 

 
 
 

If protection against accidental manipulation or handling of user rights is 
desired, change the Windows security settings to "Deny writing", as shown 
below as an example: 
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11.11 Standard files 
With the optional program NormFile ASCII files are converted by linear interpolation into a standard file 
for the calibration measurement. The step size as well as the start and end values of the source data 
are arbitrary. The source ASCII file must have the following format: 

 
E.g. 
[step size in nm]  [CR]5 
[initial wavelength in nm]  [CR]300 
[End wavelength in nm]  [CR]900 
[Realwert]  [CR]4.95029144673026E+0001 
[Realwert]  [CR]5.10178270335309E+0001 
 .. 
 .. 
[Realwert]  [CR]5.10178270335309E+0001 

 
Press the Open button to land a corresponding source file. The step size, the start wavelength and the 
end wavelength will be displayed in the left fields. 
Now you can change the step size and the wavelength range for the target data in the right input 
fields. These depend on the type of instrument used. For the standard spectrometer, these are already 
predefined. 
Now press the "Save" button. The program then performs the interpolation and sets target values that 
could not be interpolated to 0. This is the case if the wavelength range of the source file does not 
cover the complete wavelength range of the target file. After the interpolation, the file name can be 
entered in a selection window. Here it is to be paid attention to the fact that the program 
SPEKTROMETER.EXE can process only files of the type .DAT. Therefore you should always enter 
the type .DAT at this point. The standard files must be located in the subdirectory KOR. 

 
ATTENTION! An already existing file will be overwritten without confirmation. Therefore, backup 
copies should be created. 

 
The destination file has the following format. 

 
 

e.g. Halnorm.dat 
 

[Number of spectra(always 1)]  [CR]1 
[Realwert]  [CR]4.95029144673026E+0001 
[Realwert]  [CR]5.10178270335309E+0001 

 .. 
 .. 

[Realwert]  [CR]5.10178270335309E+0001 



1 Technical data 51  
 

 
 1Technical  data 

 
 

General data 
Ambient temperature +5 to 40 °C 

Storage temperature, approx. -10 to +50 °C 

Humidity 0% to 80% rel. humidity 

Cooling Air cooling 
 

Mounting position, minimum distances 
Body position horizontal 

Minimum distances, top 2 cm 

Minimum distances, lateral 2 cm 
 
 

Spectral ranges 
Classification of spectral ranges According to CIE 
UV-C 200 - 280 nm 
UV-B 280 - 315 nm 
UV-A 315 - 400 nm 
VIS 380 - 780 nm 

 

Control port and optical parameters 
See data sheet spectrometer / on request 

 
 

Light guide 
Fiber optic cable connection SMA-905 

Bending radius > 200 mm 
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2 Spare parts, calibration and maintenance 

Contact for replacement orders, recalibrations and 
maintenance needs: 

 
 

Opsytec Dr. Gröbel GmbH 
Am Hardtwald 6-8 
76275 Ettlingen 
Germany 
Phone +49 - 7243 - 94 783 - 50 

Fax +49 - 7243 - 94 783 - 65 
 

Visit us on the Internet: www.opsytec.de 

http://www.opsytec.de/
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3 Declaration of conformity 

 
We hereby declare, 

 

 
 
 

that we have the following 
product 

Opsytec Dr. Gröbel GmbH 
Am Hardtwald 6-8 

76275 Ettlingen 

 

Spectrometer SR900 with software 
SRpro 

 

Type designation: 
 

SR900 and SRpro 
 
 

have developed, designed and manufactured under their sole responsibility and that 
the product conforms to the following standard(s) or guideline(s) in this declaration: 

 
2014/35/EU 
"Directive of the European Parliament and of the Council on the harmonization of the 
laws of Member States relating to the making available on the market of electrical 
equipment designed for use within certain voltage limits (Low Voltage Directive)". 

 
2006/42/EC 
"Directive of the European Parliament and of the Council on machinery and amending 
Directive 95/16/EC (Machinery Directive)". 

 
 

Ettlingen, 19.05.2017 
 
 

Dr. Mark Paravia 
Management 


	1 Contents s directory
	2 Preface
	Dear customer!
	Thank you for choosing a product from us!
	Please take some time to read this manual carefully. Please pay special attention to the safety instructions.
	This is the condition for safe handling and operation of the system and its components.
	If you have any questions that are not answered in this manual, please feel free to call us. We will be glad if we can help you. We are also always happy to receive suggestions or ideas.
	Our products are subject to constant further development; therefore, there may be minor deviations between your system and the illustrations in this operating manual.
	2017
	Opsytec Dr. Gröbel GmbH Am Hardtwald 6-8
	D - 76275 Ettlingen
	Tel.: +49(0)7243 / 9 47 83-50
	Fax: +49(0)7243 / 9 47 83-65
	info@opsytec.de
	All rights reserved. Reprinting, including excerpts, is only permitted with the written consent of Opsytec Dr. Gröbel GmbH.

	3 Quick guide spectroradiometric measurement
	The short instructions are intended to demonstrate the function of the spectrometer by means of an operating sequence. The detailed instructions can be found starting on page 24. Please observe the safety instructions in these instructions.
	The goal of the Quick Start Guide is that you end up with a measured spectrum on your screen.
	1. Start the SRpro program.
	The program starts with a welcome screen and starts the connection to the spectrometer.
	When starting for the first time, set the user to Power User if necessary. See Start > Options > User
	You will find the password as an attachment to these instructions.
	2. Check in the main window that the following buttons are active:
	3. Hold the diffuser against a light source Start themeasurement
	A status window is opened. This shows the current integration time
	is output. The integration time is changed several times to achieve a modulation of approx. 90%. If the correct integration time is found, the window is hidden again and the actual measurement is started.
	4. If necessary, continue with the manual dark measurement. Your spectrometer is then ready for operation.
	Notes for calibrated measurements:
	To perform a calibrated measurement, please select the button " Spectral correction relative" or " Spectral correction absolute". The selection of one of these two buttons releases the drop-down list for the correction file.
	In this list, select one of the correction files that came with your spectrometer. Please note that the file must match the input optics used (fiber optics, U-ball, diffuser, etc.).
	We recommend the use of dark measurements for absolute irradiance measurements, the
	Stray light correction and an averaging over 3 to 20 measurements.

	4 Quick guide transmission / reflection measurement
	The short instructions are intended to demonstrate the function of the spectrometer by means of an operating sequence. The aim of the short instructions is that you have a measured spectrum on your screen at the end.
	1. Start the SRpro program.
	The program starts with a welcome screen and starts the connection to the spectrometer.
	When starting for the first time, set the user to Power User if necessary. See Start > Options > User
	You will find the password as an attachment to these instructions.
	2. Check in the main window that the following buttons are active:
	3. Connect the light guide for transmission or reflection
	4. Set the integration time and the number of measurements. Typical:
	a. for transmission measurements e.g. 200 ms and 10 measurements
	b. for reflection measurements with an integrating sphere e.g.30000 ms and >3 measurements
	5. Start the measurement Start themeasurement
	After the dark measurement, which takes a few seconds, you will be prompted to
	to start the 100% measurement (baseline).
	6. Then insert the sample (Note Sample measurement).
	7. After that, the measurement appears on the screen.
	We recommend using dark measurement, stray light correction and averaging over 10 to 100 measurements.

	5 Guidelines and standards
	The system is a machine according to Annex II A of the Machinery Directive and is therefore supplied with a declaration of conformity and a CE marking (in accordance with the Machinery Directive).

	6 Identification
	6.1 manufacturer
	Opsytec Dr. Gröbel GmbH Am Hardtwald 6-8
	D - 76275 Ettlingen
	Tel.: +49(0)7243 / 9 47 83-50
	Fax: +49(0)7243 / 9 47 83-65
	info@opsytec.de www.opsytec.de

	6.2 Change history
	We reserve the right to make changes to the content. Opsytec Dr. Gröbel GmbH is not liable for any errors in this documentation. No liability is accepted for indirect damage arising from the supply or use of this documentation, to the extent permitted...

	6.3 Copyright
	Opsytec Dr. Gröbel GmbH shall retain the copyright for this operating manual. The operating manual is intended for the owner/operator and his personnel.
	Reproduction and copying of this document, use and disclosure of the contents in this document are strictly prohibited unless expressly authorized.
	Non-compliance may lead to a claim for damages. All rights in the case of a patent application, utility model or design are reserved.
	Violations may be subject to criminal prosecution.

	6.4 General identifier
	Data for internal use:

	6.5 Terms of use
	The system is intended for industrial use only. It is forbidden to use the devices in explosive environments or for general illumination
	 Installation, commissioning, operation, maintenance and service work may only be carried out by trained and qualified personnel who comply with all safety guidelines and standards.
	 Responsibility: Damage resulting from unintentional or unauthorized tampering terminates any right to assert warranty or liability claims against the manufacturer.
	 Warranty Disclaimer: The use of any non-original parts will void the warranty.
	 Environmental protection: Defective parts containing substances harmful to the environment must be disposed of accordingly.
	 Operation is only permitted in a dry environment. The installation is horizontal.
	 Only suitable for indoor operation.
	 Before opening, the system must be disconnected from the voltage and it must be checked that there is no voltage.
	 Wear gloves for servicing, cleaning and replacing the light guides and optical components.
	 Do not clean the system when it is in operation.
	 The housing must not be opened by the user. The optically active surface must not be touched.
	 Gloves must be worn for cleaning the optically active surface.
	 The SR900 is a highly sensitive optical measuring instrument. It must not be subjected to shocks.
	 When using the system, light and UV radiation may be reflected and scattered by the measuring head. If necessary, suitable protective measures must be used to protect against radiation.
	 Any use other than that mentioned above will result in damage to the product. Furthermore, this is related to dangers such as short circuits, fire and electric shock. The entire device must not be changed and/or modified! The safety instructions mus...

	6.6 Foreseeable misuse
	The following is considered a foreseeable misuse:
	 Operation of the device without safety devices and safety equipment.
	 Activities of untrained personnel on the equipment.
	 Failure to follow the owner/operator's operating instructions.
	 Ignoring the operating manual.
	 Any use outside the specified purpose.

	6.7 Legal information
	6.7.1 Limitation of Liability
	All information in this manual has been compiled taking into account the currently applicable standards and regulations, the technical standard and our many years of knowledge and experience.
	The manufacturer is not liable for damages in the event that:
	 This manual was ignored,
	 the device has been used improperly,
	 untrained personnel were used,
	 untrained personnel have used the machine incorrectly,
	 inadmissible modifications have been made,
	 technical changes have been made
	 unauthorized spare parts have been used.
	We are not liable for common faults of the device caused by a power failure or a failure of the control system.
	The actual scope of delivery may differ from the explanations and pictures in this manual in the case of special versions, when additional options are ordered, or due to the latest, technical changes.
	The obligations agreed in the delivery contract, as well as the manufacturer's delivery conditions and the legal regulations valid at the time of the conclusion of the contract shall apply.

	6.7.2 Conformity of declaration
	The declaration of conformity can be found in the appendix or can be requested from the manufacturer.

	6.7.3 Warranty terms
	The warranty conditions are subject to the Civil Code (BGB) of the Federal Republic of Germany. The warranty period is 1 year, unless otherwise agreed in the purchase documents.



	7 General
	7.1 Information about this manual
	This manual is intended to make the handling of this system and its components safe and efficient. This manual is part of the system and must be kept in its immediate environment, where it is accessible to personnel at all times.
	This documentation contains the necessary information for the intended use of the system described. It is intended for technically qualified personnel who have been specially trained for operation, quality assurance, laboratory, maintenance and repair.
	The personnel must have read this manual carefully and understood its contents before starting any work. The basic condition for safe working is the observance of all mentioned safety notes and operating instructions in this manual.
	Knowledge and technically correct implementation of the instructions, safety requirements and warnings are a condition for safety during operation, maintenance and repair. Only qualified personnel have the necessary expertise to apply the safety instr...
	In addition, the local accident prevention regulations and the general safety regulations for the area of application of the system apply.
	Illustrations in this manual are for general understanding; they may differ from the actual version.
	Apart from this manual, the instructions for the installed components contained in the appendix apply.
	This operating manual cannot cover every possible maintenance case. If you require further information or if special problems occur which are not covered comprehensively enough in this manual, please request the necessary information from the manufact...
	For ease of description, the above components are collectively referred to as the system.

	7.2 Information about the symbols
	7.2.1 Safety instructions
	In this manual, safety instructions are represented by symbols. The safety instructions are preceded by signal words indicating the extent of the danger.
	To avoid accidents and damage to persons or property, always follow the information and act prudently.
	Throughout the text you will find the following pictograms  with the following meanings:
	Information about the application or useful, important information

	7.2.2 Prohibition signs
	General "prohibition sign

	7.2.3 Warning signs
	7.2.4 Attention
	7.2.5 Optional function

	7.3 owner/operator information
	The system is used on the commercial environment. The owner/operator of the system is therefore subject to the legal obligations regarding occupational safety.
	In addition to the safety information in this manual, the generally applicable regulations valid for the area of application of the system with regard to safety, prevention of accidents and protection of the environment must be observed and complied w...
	The following applies in particular:
	The owner/operator must acquire information about the valid occupational health and safety regulations and determine in a risk assessment additional hazards that have arisen due to the special operating conditions at the place of use of the system. He...
	The owner/operator is required throughout the life of the system to verify that the operating instructions it has developed are in compliance with the current regulatory status and must update them as necessary.
	The owner/operator must clearly assign and define responsibilities for installation/operation, troubleshooting, service and cleaning.
	The owner/operator must ensure that all personnel dealing with the system have read and understood this manual. Furthermore, he is obliged to offer personnel training at regular intervals and to provide information about the risks and hazards.
	The owner/operator must provide the required personal protection equipment for his personnel. Furthermore, the owner/operator is responsible for ensuring that the system is always in a faultless technical condition. To ensure this, the service interva...
	The owner/operator must regularly check all safety devices for function and completeness.
	The owner/operator must ensure that the operating personnel have knowledge of first aid measures and the local rescue equipment.

	7.4 Personnel requirements
	7.4.1 Qualifications
	Below, the manual lists the personnel qualifications for the various areas of activity:
	Based on their training, competence, experience and knowledge of the relevant standards and regulations, qualified electricians perform work on the electrical equipment and independently identify and avoid risks.
	Qualified electricians are specially trained for the working environment in which they work and they know the relevant standards and regulations. Qualified electricians must meet the requirements of the applicable legal regulations for accident preven...
	Qualified specialists are or can be trained by Opsytec Dr. Gröbel GmbH in the advanced operation and parameterization of the system, as well as in the performance of preventive service work.
	In addition to their technical training, competence and experience, as well as their knowledge of the relevant standards and regulations, they are able to carry out the work assigned to them and independently recognize and avoid possible hazards.
	Operators use and operate the system within the scope of its intended use. They are trained by the owner/operator in the work assigned to them and informed about possible hazards.

	7.4.2 Training and qualification of personnel
	In regular instructions and training, the operating personnel must be informed about the special risks and dangers when working with and handling the system.
	The instruction and training should have the following content: Hazards when working with the system in normal operation.
	Hazards associated with service, repair and cleaning activities. Behavior to minimize accident consequences.
	Behavior in case of accidents. Rescue of injured persons.
	Working without personal protective equipment can cause damage to health. The company supervisor is instructed to ensure that the personnel wear personal protective equipment.
	Special hazards when working on electrical equipment.
	The instructions and training must be carried out at regular intervals by the owner/operator. For better tracking, the implementation of the instruction and training should be recorded.

	7.4.3 Personal protective equipment
	The purpose of personal protective equipment is to protect personnel from hazards that could affect their safety or health at work.
	When performing various activities on and with the system, the personnel must wear personal protective equipment. This is repeatedly referred to in the individual chapters of this manual. The personal protective equipment is explained below:
	Protective gloves are used to protect hands from visible and/or invisible radiation, friction, abrasions, stings and deep injuries.
	Safety glasses are used to protect the eyes from visible and/or invisible.
	Safety shoes are worn as protection from heavy parts that could fall and from slipping on slippery surfaces.



	8 Safety instructions and residual risk
	8.1 Gerneral
	The system is state of the art and has been built in accordance with recognized safety regulations. Nevertheless, its use may pose risks to the life and extremities of the operating and repair personnel (service personnel) or third parties, or impair ...
	The following safety information must be strictly observed to avoid damage to the machine and personal injury!

	8.2 Safety instructions relating to normal operation
	The wearing of personal protective equipment (e.g. safety goggles and hand protection) is mandatory when working on the system.

	8.3 Radiation safety
	The risk assessment for the workplace is the responsibility of the customer. This requires measurements / assessments according to DIN EN 14255-1:2005-06 "Measurement and assessment of personal exposure to incoherent optical radiation - Part 1: Ultrav...
	DIN 14255-1 itself does not contain any limit values. These are given in Directive "2006/25/EC of the European Parliament and of the Council on the minimum health and safety requirements regarding the exposure of workers to the risks arising from phys...

	8.4 Safety instructions relating to service and repair work
	Service, repair and cleaning work may only be carried out by authorized and specially trained personnel. The system must be de-energized and secured before major work (including cleaning) is performed).
	Carry out the prescribed adjustment, service and inspection work in accordance with the instructions. If you require further information in this connection, or if special problems arise which are not dealt with comprehensively enough in this manual, p...
	The housing must not be opened by the user. The optically active surface must not be touched.
	Gloves must be worn for cleaning the optically active surface.
	The SR900 is a highly sensitive optical measuring instrument. It must not be subjected to shocks.


	9 Description of the system and function overview
	The compact SR900 spectroradiometer is a high-resolution measuring system for fast and precise measurements in the UV, visible spectral range and IR. The measuring range extends from 200 nm to 1100 nm. The spectroradiometer consists of an array spectr...
	The SR900 is traceable to the PTB factory calibrated. DAkkS testing in our accredited laboratory is optionally available. The SR900 thus allows accurate spectroradiometric measurements for the evaluation of irradiances and illuminances, biological eff...
	For the SR900, we also carry an extensive range of accessories, which can be combined with customer-specific extensions.
	With version 4.0 we already introduced an extended user administration. This makes it possible to switch the user interface permanently between a main user, with all functions, and a restricted user. A password is required for the switchover, which is...
	The user rights differ as follows:
	For example, the restricted user is not able to change the following settings:
	- Change printer settings and log settings
	- Change dynamic measurement
	- Change spectral correction off / relative / absolute
	- Change correction file
	- Change offset correction
	- Change dark measurement
	- Perform data manipulation
	- Accidentally overwrite files
	9.1 General product description:
	9.2 The following components are supplied:
	For ease of description, the above components are collectively referred to as the system.
	The following components are required by the customer:



	10 Commissioning
	 Unpack all components and remove the packing materials.
	10.1 Software installation
	- Connect the USB stick or CD to the PC and double-click Setup.exe.
	- Follow the installation instructions on the screen and confirm the installation of the drivers.

	10.2 Removing SR900
	If necessary, you can remove SR900 from your computer. You can do this in the following ways:
	- Click on "Start" in the Windows Start menu and select "Programs > SRpro > Remove SRpro".
	- Select "Settings > Control Panel" in the Windows "Start" menu. Double-click
	-         on"Software"in the control panelSelectSRpro in the dialog box.
	-      Software Properties"on the tab page
	Install/Uninstall"and click the button
	"Add/Remove".

	10.3 Installing device drivers under Windows 8
	In Windows 8, it is no longer possible to install unsigned drivers by default. However, you can allow unsigned drivers.
	This tutorial shows how this can be done.
	- Key +i
	- Press and hold the Shift key and click Restart. Do not release the Shift key until the following screen appears.
	- Now click on Troubleshoot
	- And then click on Advanced Options
	- Then click on Startup Settings
	- Click on "Restart" in the subsequent message.
	- The computer will then restart.
	- When restarting, the startup settings appear
	- Now allow the unsigned drivers with the number key 7 or the function key F7. Windows is then started.
	- During the installation of the driver, a prompt will now appear. Press "Install this driver software anyway".


	11 Software operation
	11.1 The controls
	11.2 The spectral diagram
	At the top left of the screen you can see the units, at the bottom right the level. The largest part of the screen is the graphical representation of the spectrum.  In horizontal direction the wavelength is displayed, in nm and in vertical direction t...
	The lower part of the screen contains the display of the current cursor position and the controls for managing multiple spectra.
	By clicking and holding the left mouse button, a rubber band can be drawn. The section when releasing the left mouse button is zoomed out and displayed enlarged in the spectral window.
	The Pan function is used to move the graphic. To activate the pan function, the CTRL key must be held. When the mouse pointer is in the graphic, it changes the shape to a cross. Now the graphic can be moved by pressing and holding the left mouse button.
	Clicking the right mouse button within the graphic opens the context menu.
	Under Zoom Auto. Scale can be switched on/off, return to the full range or display the ordinate 10% or 20% larger than the maximum signal.
	If the menu item "Scan graph" is selected, a crosshair is displayed as soon as the mouse is in the spectral display. This crosshair follows the mouse movement and is always assigned to the wavelength of the mouse position.
	Under the item "Edit" the spectral graph can be copied to the clipboard or saved as a bitmap file. Using these functions, it is possible to transfer the spectral display to a word processing program for documentation purposes.
	The bottom item "Start measurement" starts a new measurement.
	If the menu item "Scan graph" is selected, a crosshair is displayed as soon as the mouse is in the spectral display. This crosshair follows the mouse movement and is always assigned to the wavelength of the mouse position.
	Under the item "Edit" the spectral graph can be copied to the clipboard or saved as a bitmap file. Using these functions, it is possible to transfer the spectral display to a word processing program for documentation purposes. With the function "Copy ...

	11.3 Working with multiple spectra
	Figure 1: Selection list for active spectrum

	11.4 Symbol overview
	Figure 2: The calculation of the dynamic spectrum
	Figure: The math window for data manipulation
	Window settings color

	11.5 File menu
	11.6 Window menu
	11.7 Analysis menu
	11.8 Options menu
	Recommended settings: 30% to 90%

	11.9 Edit menu
	11.10 Calibration menu*
	If an existing calibration file is overwritten by the calibration measurement, this is not reversible.

	11.11 Standard files
	e.g. Halnorm.dat
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